
 

GATHERING THE DATA (USING ONLINE/OFFLINE) 

EXPERIMENT -I 

Create questioner of Marketing/HR/Revenant Management Stream: 

GATHERING PRIMARY DATA 

• Primary data collection is a process of collecting original data, directly from 

the source. 

• It is used in research to gather first-hand information about a problem or topic. 

• The most common use for primary data is in studies, where researchers need 

to collect information from experts in their field. 

• Offline primary data collection includes: 

1. Offline surveys, 

2. Interviews, 

3. Offline quizzes, 

4. Delphi technique, 

5. Focus groups 

6. Observations. 

Online primary data collection includes: 

1. Web scraping, 

2. Online quizze, 

3. Online surveys. 

Self-collection includes using social media to collect information Illustration of 

the most common primary data collection types. 



 

 

 

 

Entering online survey data in to excel 

Go to menu 

Go back to page 

Export Data to MS Excel 

Under the Report tab, you analyze aggregate information about your 

survey responses. To extract raw data, you can navigate to the Data tab and 

download/export your raw response in the format of your choice. 

For example, let’s say you’d like your data in an Excel spreadsheet. Not a 

problem! As soon as you have results, you can seamlessly download survey 

data into Excel for additional analysis outside the Sogolytics platform at any 

time. Sogolytics’s Data tab gives you instant access to your data in the format 

that you need. 



 

Below is a step-by-step guide to export survey data in Excel: 

 

 

Select your survey, then click Data. From the Export options presented, click on 

Excel. 

A pop-up will appear, asking you to prepare your raw data for export. 

Click Continue to proceed. 

As your data is prepared, you can navigate to other sections to complete 

any other tasks. A confirmation email will be sent to the email address you 

identified under Settings as a notification when the export process is completed. 

Once your data is prepared, click on Export Responses. 

You can directly export raw data to Excel once your survey is prepared. 

You will not need to prepare data for your survey again unless you have 

received a new response for your survey, excluded a response, or made textual 

changes to your survey questions. 

On the ‘Select Survey Questions’ step, you may choose to select all or 

selected question for which you would like to export your raw data. 

Click on Continue to add additional attributes or click Export Now to 

export your raw data in Excel. 

In the ‘Select Export Attributes’ step, you may customize the attributes to 

be included. Options include Respondent, Response, and Assessment Attributes. 

Click Continue to proceed. 

Email Address will only be displayed for Unique invitations/Access 

Codes or survey participation using authentication. 

IP address will only be displayed if the survey is not anonymous. 

Exclude responses will be enabled only for responses marked as Excluded in an 

individual report. 

Assessment Attributes will be enabled only for surveys under the Assessment 

Tool. 

Under ‘Select Survey Conditions’ step, you can: 



 

Filter responses based on response to a question in your survey 

Filter responses based on time period 

Next, you can assign codes to your survey. This is typically only useful 

when you are working with SPSS or other statistical software or need to make 

textual changes to your question and answer text. 

Finally, select the range of responses to export. This step is only 

necessary if you have more than 10,000 responses, as you may export 10,000 

responses at a time. Click Export. 

Sorting and Filtering the required shape 

Sorting 

Excel provides a number of basic capabilities for sorting and filtering 

data in a worksheet. These capabilities are accessible from the Data ribbon. 

Example 1: Sort the data in the range A3:D10 of Figure 1 by income 
 

 

 

Figure 1 – Data to be sorted 

 

Highlight the range A3:D12 and select Data > Sort & Filter|Sort. When the 

dialog box shown in Figure 2 appears, choose Income for the Sort by field and 

make sure that the My data has headers field is checked. 



 

 

 

Figure 2 – Sort dialog box 

 

Once you click on the OK button the data in range A3:D12 will be overwritten 

with the data in sorted order as shown in Figure 3. 

 

 

Figure 3 – Data sorted by Income 

 

Multiple Sorts 

Now suppose that in the case of ties we wanted the entries to be sorted in 

alphabetic order by the person’s name. Notice that three people have an income 

of 35,000 and two have an income of 45,000. In neither case are the entries in 

alphabetic order by name. To perform a multilevel sort you need to press Add 

Level button in Figure 2. The dialog box will change to give you the 

opportunity to supply two sort keys. Fill in the entries as shown in Figure 4. 



 

 

Figure 4 – Multiple level sort 

 

This time the data will be sorted as shown in Figure 5. 

 

 

Figure 5 – Data sorted by Income/name 

 

EXPERIMENT II 
 

Collecting and Entering the Secondary Data: 

 

Secondary data refers to data that is collected by someone other than the 

primary user. Common sources of secondary data for social 

science include censuses, information collected by government departments, 

organizational records and data that was originally collected for other research 

purposes. Primary data, by contrast, are collected by the investigator conducting 

the research. 

Secondary data analysis can save time that would otherwise be spent 

collecting data and, particularly in the case of quantitative data, can provide 

larger and higher-quality databases that would be unfeasible for any individual 

researcher to collect on their own. In addition, analysts of social and economic 

https://en.wikipedia.org/wiki/Data
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https://en.wikipedia.org/wiki/Census
https://en.wikipedia.org/wiki/Primary_data
https://en.wikipedia.org/wiki/Quantitative_data
https://en.wikipedia.org/wiki/Database


 

change consider secondary data essential, since it is impossible to conduct a 

new survey that can adequately capture past change and/or developments. 

However, secondary data analysis can be less useful in marketing 

research, as data may be outdated or inaccurate. 

Sources of Secondary Data: 

Secondary data can be obtained from many sources: 
 censuses and government departments like housing, social security, electoral 

statistics, tax records 

 internet searches and libraries 

 GPS and remote sensing 

 km progress reports 
 journals, newspapers and magazines 

Advantages and Disadvantages of Secondary Data: 

Secondary data is available from other sources and may already have 

been used in previous research, making it easier to carry out further research. It 

is time-saving and cost-efficient: the data was collected by someone other than 

the researcher. Administrative data and census data may cover both larger and 

much smaller samples of the population in detail. Information collected by the 

government will also cover parts of the population that may be less likely to 

respond to the census (in countries where this is optional). 

A clear benefit of using secondary data is that much of the background 

work needed has already been carried out, such as literature reviews or case 

studies. The data may have been used in published texts 

and statistics elsewhere, and the data could already be promoted in the media or 

bring in useful personal contacts. Secondary data generally have a pre- 

established degree of validity and reliability which need not be re-examined by 

the researcher who is re-using such data. Secondary data is key in the concept of 

data enrichment, which is where datasets from secondary sources are connected 

to a research dataset to improve its precision by adding key attributes and 

values. 

Secondary data can provide a baseline for primary research to compare 

the collected primary data results to and it can also be helpful in research 

design. 

However, secondary data can present problems, too. The data may be out 

of date or inaccurate. If using data collected for different research purposes, it 

may not cover those samples of the population researchers want to examine, or 

not in sufficient detail. Administrative data, which is not originally collected for 

research, may not be available in the usual research formats or may be difficult 

to get access to. 

https://en.wikipedia.org/wiki/Census
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STATISTICAL ANALYSIS (USING EXCEL/SPSS//R-STUDIO OPEN- 

SOURCE ONLINE TOOLS) 

 

EXPERIMENT III 

Formulation of Hypothesis 
The hypothesis is a predictive, testable statement predicting the outcome 

and the results the researcher expects to find. 

 

Importance of Hypothesis in Research 

The purpose of including hypotheses in psychology research is: 

 to provide a summary of what the researcher is and how investigating a 

theory and what is expected to be found 

 to provide an answer to the research question 

 

When carrying out research the first step that researchers take is to 

investigate the research area that they are interested in. From this researchers, 

are required to identify a gap in the literature. Filling the gap essentially means 

finding what previous work has not been explained yet, investigated to a 

sufficient degree, or simply expanding or further investigating a theory if doubt 

is present. 

The researcher then forms a research question that the researcher will 

attempt to answer in their study. 

 

Steps in the Formulation of Hypothesis in Research Methodology 

All researchers will likely complete the following 

 Investigating background research in the area of interest 

 Formulating or investigating a theory 
 Identify how the theory will be tested and what the researcher expects to 

find based on relevant, previously published scientific works 

What is Univariate Analysis? 

Univariate analysis is the simplest form of analyzing data. “Uni” means 

“one”, so in other words your data has only one variable. It doesn’t deal with 



 

causes or relationships (unlike regression ) and it’s major purpose is to describe; 

It takes data, summarizes that data and finds patterns in the data. 

 

 

What is a variable in Univariate Analysis? 

A variable in univariate analysis is just a condition or subset that your 

data falls into. You can think of it as a “category.” For example, the analysis 

might look at a variable of “age” or it might look at “height” or “weight”. 

However, it doesn’t look at more than one variable at a time otherwise it 

becomes bivariate analysis (or in the case of 3 or more variables it would be 

called multivariate analysis). 

 

Univariate Descriptive Statistics 

Some ways you can describe patterns found in univariate data 

include central tendency (mean, mode and median) 

and dispersion: range , variance, maximum, minimum, quartiles (including 

the interquartile range), and standard deviation. 

 

You have several options for describing data with univariate data. Click on the 

link to find out more about each type of graph or chart: 

 

 Frequency Distribution Tables. 

 Bar Charts. 
 Histograms. 

 Frequency Polygons. 
 Pie Charts. 

Calculating univariate descriptive statistics 

Use univariate descriptive statistics to describe a quantitative variable. 

1. Select a cell in the dataset. 
2. On the Analyse-it ribbon tab, in the Statistical 

Analyses group, click Distribution, and then click the statistics to show: 

 

Option Description 

Mean and Moments Show mean, variance, standard deviation, skewness, and 

kurtosis. 

https://www.statisticshowto.com/probability-and-statistics/regression-analysis/
https://www.statisticshowto.com/probability-and-statistics/types-of-variables/
https://www.statisticshowto.com/probability-and-statistics/statistics-definitions/bivariate-analysis/
https://www.statisticshowto.com/probability-and-statistics/multivariate-analysis/
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https://www.statisticshowto.com/probability-and-statistics/descriptive-statistics/pie-chart/


 

Option Description 

Median and 

Quartiles 

Show minimum, maximum, median, and quartiles. 

Quantiles Show quantiles. 

3. The analysis task pane opens. 

4. In the Y drop-down list, select the variable. 

5. Optional: To customize the statistics to show, click Customize... and then 

select or clear the appropriate check boxes. To save the options as the defaults 

to use for future analyses, click Save as Defaults. 

6. Click Calculate. 

EXPERIMENT IV 

 

Bi Variable 

Bivariate analysis is one of the statistical analyses where two variables 

are observed. One variable here is dependent while the other is independent. 

These variables are usually denoted by X and Y. So, here we analyse the 

changes occurred between the two variables and to what extent. Apart from 

bivariate, there are other two statistical analyses, which are Univariate (for one 

variable) and Multivariate (for multiple variables). 

Definition of Bivariate Analysis 

Bivariate analysis is stated to be an analysis of any concurrent relation 

between two variables or attributes. This study explores the relationship of two 

variables as well as the depth of this relationship to figure out if there are any 

discrepancies between two variables and any causes of this difference. Some of 

the examples are percentage table, scatter plot, etc. 



 

 

For analysis, it is necessary to recognise bivariate data first. Usually, the data 

comprises two measurements such as X and Y. For each measurement, the 

bivariate data can be interpreted as the pair (X, Y). These variables are often 

called bivariate simple random sample (SRS). We can denote these variables 

as (X1, Y1), (X2, Y2),…..,(Xn,Yn). The bivariate data can be represented in a 

table as shown below: 

(Xn, Yn). The bivariate data can be represented in a table as shown below : 
 

Observations X-Variable Y-Variable 

1 10 5 

2 5 4 

3 6 3 

4 8 2 

5 4 -5 

 

Types of Bivariate Analysis 

The types of a bivariate analysis will depend upon the types of variables or 

attributes we will use for analysing. The variable could be numerical, 

categorical or ordinal. If the independent variable is categorical, like a particular 

brand of pen, then logit or probit regression can be used. If independent and 

dependent both the attributes are ordinal, which means they have position or 

ranking, then we can measure a rank correlation coefficient. If dependent 

attribute is ordinal, then ordered logit or ordered probit can be utilised. Also, if 

the dependent attribute is either ratio or interval, like temperature scale, then we 

can measure regression. So based on these data, we can mention the types of 

bivariate data analysis: 



 

1. Numerical and Numerical – In this type, both the variables of bivariate data, 

independent and dependent, are having numerical values. 

2. Categorical and Categorical – When both the variables are categorical. 

3. Numerical and Categorical – When one variable is numerical and one is 

categorical. 

What is multivariate analysis? 

 

In data analytics, we look at different variables (or factors) and how they 

might impact certain situations or outcomes. For example, in marketing, you 

might look at how the variable “money spent on advertising” impacts the 

variable “number of sales.” In the healthcare sector, you might want to explore 

whether there’s a correlation between “weekly hours of exercise” and 

“cholesterol level.” This helps us to understand why certain outcomes occur, 

which in turn allows us to make informed predictions and decisions for the 

future. 

There are three categories of analysis to be aware of: 

 

 Univariate analysis, which looks at just one variable

 Bivariate analysis, which analyzes two variables

 Multivariate analysis, which looks at more than two variables

 

As you can see, multivariate analysis encompasses all statistical techniques 

that are used to analyze more than two variables at once. The aim is to find 

patterns and correlations between several variables simultaneously—allowing 

for a much deeper, more complex understanding of a given scenario than you’ll 

get with bivariate analysis. 

Interpretation of Result 

The Interpretation (or Discussion) section of the systematic review helps 

readers interpret the main findings of the review, brought together in the 

synthesis step. 

The interpretation should include: 

 Statement of principal findings

https://careerfoundry.com/en/blog/data-analytics/covariance-vs-correlation/


 

 An analysis of those findings (for example, on what strength of the 

evidence, are the review's conclusions being made?)

 The strengths and weaknesses of the review

 A statement that places the findings in the context of the existing 

evidence base, particularly in relation to any existing relevant systematic 

reviews.

EXPERIMENT V 

VISUALISATION OF DATA 

CHART 

A chart (sometimes known as a graph) is a graphical representation for data 

visualization, in which "the data is represented by symbols, such as bars in a bar 

chart, lines in a line chart, or slices in a pie chart". A chart can 

represent tabular numeric data, functions or some kinds of quality structure and 

provides different info. 

The term "chart" as a graphical representation of data has multiple meanings: 

 A data chart is a type of diagram or graph that organizes and represents a set 

of numerical or qualitative data. 

 Maps that are adorned with extra information (map surround) for a specific 

purpose are often known as charts, such as a nautical chart or aeronautical 

chart, typically spread over several map sheets. 

 Other domain-specific constructs are sometimes called charts, such as 

the chord chart in music notation or a record chart for album popularity. 

Rules for creating charts 

1. Ask yourself a question: Start off by determining what it is that you’re 

looking for. What answer should the chart provide, and start building around 

that. 

2. Know your audience: Consider who’s going to view your graph and what 

they’ll be trying to get out of it. 

3. Make sure your data is on point: The set of information you’re dealing with 

constitutes the basis for all the charts and graphs you design. 

4. Choose the most suitable representation for the data: When trying to decide 

which chart type to use, think in terms of what the audience needs to learn from 

it. 

5. Color scheme: Even though it may seem like a negligible part of the process 

at first, choosing colors that go well together is no small matter. 

https://en.wikipedia.org/wiki/Graphics
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6. Explain encodings: Whether you’re using a color scale for magnitude, the 

size of a square to show particular values, or maybe a combination of other 

styles, you want to explain to your audience what your encoding is supposed to 

mean. 

7. Emphasize the important part: The focus can be achieved in a variety of 

ways including the color, size, or weight of the elements/indicators, as well as 

bolding or circling some of the information pieces. 

8. Consider the UX aspects: 
 Sticking to 2D as 3D is difficult to navigate, creates overlap issues, and 

looks bad in print. 

 Providing easy navigation with touch and gesture support if you expect 

mobile use. 

 Making the chart interactive to allow users to better understand the data 

and discover more. 

 Offering filters for sifting through the data. Users may need to scale 

things down to notice patterns or focus only on specific parts. 

 Avoiding too much animation as it can be distracting and overloading the 

senses. 

9. Include sourcing: when creating your graph, don’t get too caught up in all the 

arrows, columns, and other objects. Remember to always finish off your design 

with sources for the presented information. 

10. Make your chart design stand out: There are many ways to make your data 

visualization emphasize the point and be remembered. Creativity is boundless 

and in this context goes beyond the stiff frames of particular chart types. 

Add a chart title 

1. In the chart, select the "Chart Title" box and type in a title. 
2. Select the + sign to the top-right of the chart. 

3. Select the arrow next to Chart Title. 

4. Select Centered Overlay to lay the title over the chart, or More 

Options for additional choices. 

5. Right-click the chart title to format it with options like Fill or Outline. 

 

Remove a chart title 

1. Click on the chart. 

2. Select the + sign to the top-right of the chart. 
3. Uncheck the checkbox next to Chart Title. 

Axis of the Chart 

Charts typically have two axes that are used to measure and categorize 

data: a vertical axis (also known as value axis or y axis), and a horizontal axis 

(also known as category axis or x axis). 3-D column, 3-D cone, or 3-D pyramid 

charts have a third axis, the depth axis (also known as series axis or z axis), so 

https://synergycodes.com/what-we-do/
https://synergycodes.com/what-we-do/


 

that data can be plotted along the depth of a chart. Radar charts do not have 

horizontal (category) axes, and pie and doughnut charts do not have any axes. 
 

 

 

 

 

1. Vertical (value) axis 

2. Horizontal (category) axis 

3. Depth (series) axis 

The following describe how you can modify your charts to add impact and 

better convey information. For more info on what axes are and what you can do 

with them, see all about axes. 

 

 

EXPERIMENT VI 

Quick Layout 

You can use Quick Layout to change the overall layout of the chart quickly by 

choosing one of the predefined layout options. 

Step 1 − On the Ribbon, click Quick Layout. Different predefined layout 

options will be displayed. 

https://support.microsoft.com/en-us/topic/change-the-display-of-chart-axes-422c97af-1483-4bad-a3db-3a9ef630b5a9#__bkmkallaboutaxes


 

 

Step 2 − Move the pointer across the predefined layout options. The chart 

layout changes dynamically to the particular option. 

Step 3 − Select the layout you want. The chart will be displayed with the chosen 

layout. 
 

Switch Row/Column 

You can use Switch Row/Column to change the data being displayed on X-axis 

to be displayed on Y-axis and vice versa. 



 

 

Click Switch Row / Column. The data will be swapped between X-axis and Y- 

axis on the chart. 
 

 

 

Change Chart Type 

You can use the Change Chart Type button to change your chart to a different 

chart type. 

Step 1 − Click Change Chart Type. A Change Chart Type window appears. 



 

 

Step 2 − Select the chart type you want. 

Your chart will be displayed with the chart type you want. 

TYPES OF CHARTS 

A histogram consists of tabular frequencies, shown as 

adjacent rectangles, erected over discrete intervals (bins), 

with an area equal to the frequency of the observations in 

the interval. 

 

 

 

A bar chart is a chart with rectangular bars with lengths 

proportional to the values that they represent. The bars 

can be plotted vertically or horizontally. 

 

 

 

 

 

A pie chart shows percentage values as a slice of a pie. 

https://en.wikipedia.org/wiki/Histogram
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A line chart is a two-dimensional scatter plot of 

ordered observations where the observations are 

connected following their order. 

 

 

 

TIMELINE CHART ORGANISATIONAL CHART TREECHART 
 

 

 

FLOW CHART AREA CHART CARTOGRAM 
 

 

 

PEDIGREE CHART RADIAL TREE 
 

 

 

EXPERIMENT VII 

DATABASE CREATION 

https://en.wikipedia.org/wiki/Line_chart


 

To create a database 

 

1. In Object Explorer, connect to an instance of the SQL Server Database 

Engine and then expand that instance. 

2. Right-click Databases and then select New Database. 

3. In New Database, enter a database name. 
4. To create the database by accepting all default values, select OK; 

otherwise, continue with the following optional steps. 

5. To change the owner name, select (...) to select another owner. 
6. To change the default values of the primary data and transaction log files, 

in the Database files grid, select the appropriate cell and enter the new 

value. For more information, see Add Data or Log Files to a Database. 

7. To change the collation of the database, select the Options page, and then 

select a collation from the list. 

8. To change the recovery model, select the Options page and select a 

recovery model from the list. 

9. To change database options, select the Options page, and then modify the 

database options. For a description of each option, see ALTER 

DATABASE SET Options (Transact-SQL). 

10. To add a new file group, select the File groups page. Select Add and then 

enter the values for the file group. 

11. To add an extended property to the database, select the Extended 

Properties page. 

a. In the Name column, enter a name for the extended property. 

b. In the Value column, enter the extended property text. For 

example, enter one or more statements that describe the database. 

12. To create the database, select OK. 

Human resource databases refer to data related to organization, employees 

etc which is stored in one place.  

Data stored in the HR database includes employees details like personal 

information, training, salary details, reimbursement, worksheet, time chart etc. 

Secondly, data related to recruitment, transportation, expenses, clients, 

customer relationship management, finance, production etc. 

 

Human resource databases include any form of data that is needed for the 

smooth functioning of human resource management. 

https://learn.microsoft.com/en-us/sql/relational-databases/databases/add-data-or-log-files-to-a-database?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/t-sql/statements/alter-database-transact-sql-set-options?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/t-sql/statements/alter-database-transact-sql-set-options?view=sql-server-ver16


 

Creating a database 

 

When you open Access, Backstage view displays the New tab. The New tab 

provides several ways that you can create a new database: 

 A blank database You can start from scratch if you want. This is a good 

option if you have very specific design requirements or have existing data 

that you need to accommodate or incorporate. 

 A template that is installed with Access Consider using a template if you 

are starting a new project and would like a head start. Access comes with 

several templates installed by default. 

 A template from Office.com In addition to the templates that come with 

Access, you can find many more templates on Office.com. You don't even 

have to open a browser; the templates are available from the New tab. 

 

Create a blank database 

1. On the File tab, click New, and then click Blank Database. 

2. Type a file name in the File Name box. To change the location of the file 

from the default, click Browse for a location to put your database 

(next to the File Name box), browse to the new location, and then click OK. 

3. Click Create. 

Access creates the database with an empty table named Table1, and then 

opens Table1 in Datasheet view. The cursor is placed in the first empty cell 

in the Click to Add column. 

4. Begin typing to add data, or you can paste data from another source, as 

described in the section Copy data from another source into an Access table. 

Create a table, starting in Datasheet view 

In Datasheet view, you can enter data immediately and let Access build the 

table structure behind the scenes. Field names are assigned numerically (Field1, 

Field2, and so on), and Access automatically sets each field's data type, based 

on the data you enter. 

 

1. On the Create tab, in the Tables group, click Table. 

Access creates the table and selects the first empty cell in the Click to 

Add column. 

https://support.microsoft.com/en-us/office/create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808


 

2. On the Fields tab, in the Add & Delete group, click the type of field that 

you want to add. If you don't see the type that you want, click More 

Fields . 
3. Access displays a list of commonly used field types. Click the field type that 

you want, and Access adds the new field to the datasheet at the insertion 

point. 

You can move the field by dragging it. When you drag a field in a datasheet, 

a vertical insertion bar appears where the field will be placed. 

4. To add data, begin typing in the first empty cell, or paste data from another 

source, as described in the section Copy data from another source into an 

Access table. 

5. To rename a column (field), double-click the column heading, and then type 

the new name. 

You should give a meaningful name to each field, so that you can tell what it 

contains when you see it in the Field List pane. 

6. To move a column, click its heading to select the column, and then drag the 

column to the location that you want. You can also select multiple 

contiguous columns and then drag them to a new location all at once. To 

select multiple contiguous columns, click the column header of the first 

column, and then, while holding down SHIFT, click the column header of 

the last column. 

EXPERIMENT VIII 

Create a table, starting in Design view In Design view, you first create the 

table structure. You then switch to Datasheet view to enter data, or enter data by 

using some other method, such as pasting, or importing. 

 

1. On the Create tab, in the Tables group, click Table Design. 
2. For each field in your table, type a name in the Field Name column, and 

then select a data type from the Data Type list. 

3. If you want, you can type a description for each field in 
the Description column. The description is then displayed on the status bar 

when the cursor is located in that field in Datasheet view. The description is 

also used as the status bar text for any controls in a form or report that you 

create by dragging the field from the Field List pane, and for any controls 

that are created for that field when you use the Form Wizard or Report 

Wizard. 

https://support.microsoft.com/en-us/office/create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808
https://support.microsoft.com/en-us/office/create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808


 

4. After you have added all of your fields, save the table: 

 On the File tab, click Save. 
5. You can begin typing data in the table at any time by switching to Datasheet 

view and clicking in the first empty cell. You can also paste data from 

another source, as described in the section Copy data from another source 

into an Access table. 

Set field properties in Design view Regardless of how you created your 

table, it is a good idea to examine and set field properties. While some 

properties are available in Datasheet view, some properties can only be set in 

Design view. To switch to Design view, right-click the table in the Navigation 

Pane and then click Design View. To see a field's properties, click the field in 

the design grid. The properties are displayed below the design grid, under Field 

Properties. 

To see a description of each field property, click the property and read the 

description in the box next to the property list under Field Properties. You can 

get more detailed information by clicking the Help button. 

Filter the data 

Use AutoFilter or built-in comparison operators like "greater than" and “top 10” 

in Excel to show the data you want and hide the rest. Once you filter data in a 

range of cells or table, you can either reapply a filter to get up-to-date results, or 

clear a filter to redisplay all of the data. 

 

Filter a range of data 

 

1. Select any cell within the range. 

2. Select Data > Filter. 
 

Create Models Using Marketing Data 

A data model is a conceptual representation of various metrics that you need to 

track. 

https://support.microsoft.com/en-us/office/create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808
https://support.microsoft.com/en-us/office/create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808


 

A marketing data model organizes elements of data that your campaigns collect 

to determine how those elements relate to each other, allowing you to spot 

relationships, glean insights, and determine how to improve results by making 

changes to your marketing strategy. 

In short, data modelling is the process of identifying, analyzing, displaying, and 

communicating data sets, allowing them to be more easily understood so that 

you can use them to make marketing decisions. 

Below, we’ll discuss how different types of data modelling methods are used by 

digital marketers. 

Customer Personas 

A customer persona is the fundamental archetype of your ideal, target 

consumer. By using data modelling techniques, you can construct the ideal 

customer, determining all the different features they exhibit (from age to marital 

status, to household income, to interests, etc.), to help determine WHO exactly 

you should be targeting with your marketing dollars. 

Engagement 

After determining your target audience, running campaigns against them, and 

collecting the resulting performance data, you can now leverage data modelling 

strategies to measure their engagement, understand which parts of your 

campaign are working (as well as why they’re working), so that you can 

uncover insights that will lead to better results in the future. 

Optimization 

Marketing optimization is all about leveraging the data you’ve collected to 

uncover learning’s that can help enhance your marketing decisions, and 

therefore, results. 

Internal Rate of Return (IRR) 

Internal Rate of Return is the interest rate that makes the Net Present Value 

Zero. 

And that "guess and check" method is the common way to find it (though in that 

simple case it could have been worked out directly). 

STEPS OF CALCULATION OF IRR 

Step 1: Select 2 discount rates for the calculation of NPVs 

You can start by selecting any 2 discount rates on a random basis that will be 

used to calculate the net present values in Step 2. 

It is important not to select discount rates that are ridiculously distant from the 

IRR (e.g. 10% and 90%) as it could undermine accuracy. 



 

Step 2: Calculate NPVs of the investment using the 2 discount rates 

You shall now calculate the net present values of the investment on the basis of 

each discount rate selected in Step 1. 

Step 3: Calculate the IRR 

Using the 2 discount rates from Step 1 and 2 calculate net present values . Then 

you shall calculate the IRR 

Step 4: Interpretation 

The decision rule for IRR is that an investment should only be selected where 

the cost of capital (WACC) is lower than the IRR. 

The decision rule above will lead to the same conclusion as the NPV analysis 

where only one investment is being considered. 

EXPERIMENT IX 

INTRODUCTION TO MS-ACCESS & SPSS 

 

Microsoft Access is a Database Management System (DBMS) from Microsoft 

that combines the relational Microsoft Jet Database Engine with a graphical 

user interface and softwaredevelopment tools. It is a member of the Microsoft 

Office suite of applications, included in the professional and higher editions. 

 Microsoft Access is just one part of Microsoft’s overall data management 

product strategy. 

 It stores data in its own format based on the Access Jet Database Engine. 
 Like relational databases, Microsoft Access also allows you to link 

related information easily. For example, customer and order data. 

However, Access 2013 also complements other database products 

because it has several powerful connectivity features. 

 It can also import or link directly to data stored in other applications and 

databases. 

 As its name implies, Access can work directly with data from other 

sources, including many popular PC database programs, with many SQL 

(Structured Query Language) databases on the desktop, on servers, on 

minicomputers, or on mainframes, and with data stored on Internet or 

intranet web servers. 

 Access can also understand and use a wide variety of other data formats, 

including many other database file structures. 

 You can export data to and import data from word processing files, 

spreadsheets, or database files directly. 

 Access can work with most popular databases that support the Open 

Database Connectivity (ODBC) standard, including SQL Server, Oracle, 

and DB2. 



 

 Software developers can use Microsoft Access to develop application 

software. 

Microsoft Access stores information which is called a database. To use MS 

Access, you will need to follow these four steps − 

 Database Creation − Create your Microsoft Access database and specify 

what kind of data you will be storing. 

 Data Input − After your database is created, the data of every business 

day can be entered into the Access database. 

 Query − This is a fancy term to basically describe the process of 

retrieving information from the database. 

 Report (optional) − Information from the database is organized in a nice 

presentation that can be printed in an Access Report. 

Tables 

Tables are essential objects in a database because they hold all the information 

or data. For example, a database for a business can have a Contacts table that 

stores the names of their suppliers, e-mail addresses, and telephone numbers. 

Because other database objects depend so heavily on tables, you should always 

start your design of a database by creating all of its tables and then creating any 

other objects. Before you create tables, consider your requirements and 

determine all the tables that you might need. For an introduction to planning and 

designing a database, see Database design basics. 

Overview 

A relational database like Access usually has several related tables. In a well- 

designed database, each table stores data about a particular subject, such as 

employees or products. A table has records (rows) and fields (columns). Fields 

have different types of data, such as text, numbers, dates, and hyperlinks. 
 

1. A record: Contains specific data, like information about a particular 

employee or a product. 

2. A field: Contains data about one aspect of the table subject, such as first 

name or e-mail address. 

https://support.microsoft.com/en-us/office/database-design-basics-eb2159cf-1e30-401a-8084-bd4f9c9ca1f5


 

3. A field value: Each record has a field value. For example, Contoso, Ltd. 

or someone@example.com. 

Top of Page 

Table and field properties 

Tables and fields also have properties that you can set to control their 

characteristics or behavior. 
 

1. Table properties 

2. Field properties 

EXPERIMENT X 

Overview of primary keys in Access 

Access uses primary key fields to quickly associate data from multiple tables 

and combine that data in a meaningful way. You can include the primary key 

fields in other tables to refer back to the table that is the source of the primary 

key. In those other tables, the fields are called foreign keys. For example, a 

Customer ID field in the Customers table might also appear in the Orders table. 

In the Customers table, it is the primary key. In the Orders table it is called a 

foreign key. A foreign key, simply stated, is another table's primary key. For 

more information, see Database design basics. 

mailto:someone@example.com
https://support.microsoft.com/en-us/office/introduction-to-tables-78ff21ea-2f76-4fb0-8af6-c318d1ee0ea7
https://support.microsoft.com/en-us/office/database-design-basics-eb2159cf-1e30-401a-8084-bd4f9c9ca1f5


 

 

1. Primary key 

2. Foreign key 

If you are moving existing data into a database, you may already have a field 

that you can use as the primary key. Often, a unique identification number, such 

as an ID number or a serial number or code, serves as a primary key in a table. 

For example, you might have a Customers table where each customer has a 

unique customer ID number. The customer ID field is the primary key. 

Access automatically creates an index for the primary key, which helps speed 

up queries and other operations. Access also ensures that every record has a 

value in the primary key field, and that it is always unique. 

When you create a new table in Datasheet view, Access automatically creates a 

primary key for you and assigns it a field name of "ID" and the AutoNumber 

data type. 

What makes a good primary key? 

 

A good candidate for a primary key has several characteristics: 

 It uniquely identifies each row 

 It is never empty or null — it always contains a value 
 The values it contains rarely (ideally, never) change 

The Ribbon contains a series of command tabs. In MS-Access 2007, the main 

command tabs are as follows: Read more on Sarthaks.com - 

https://www.sarthaks.com/125723/explain-ms-access-ribbon 

• Home 

http://www.sarthaks.com/125723/explain-ms-access-ribbon


 

• Create 

• External Data 

• Database Tools 

When you first start Access, or if you close a database without closing Access, 

Microsoft Office Backstage view is displayed. 

Backstage view is a starting point from which you can create a new database, 

open an existing database, view featured content from Office.com — anything 

you can use Access to do to a database file or outside of a database, as opposed 

to within a database. 

Creating a database 

 

When you open Access, Backstage view displays the New tab. The New tab 

provides several ways that you can create a new database: 

 A blank database You can start from scratch if you want. This is a 

good option if you have very specific design requirements or have 

existing data that you need to accommodate or incorporate. 

 A template that is installed with Access Consider using a template if 

you are starting a new project and would like a head start. Access comes 

with several templates installed by default. 

 A template from Office.com In addition to the templates that come 

with Access, you can find many more templates on Office.com. You 

don't even have to open a browser, the templates are available from the 

New tab. 

What is SPSS? 

 

SPSS (Statistical Package for the Social Sciences) is a versatile and 

responsive program designed to undertake a range of statistical 

procedures. SPSS software is widely used in a range of disciplines and is 

available from all computer pools within the University of South Australia. 

It’s important to note that SPSS is not the only statistical software – there are 

many others that you may come across if you pursue a career that requires you 

to work with data. Some of the other more common statistical packages include 

Stata and SAS (and there are many others). The focus for this session, however, 

is on SPSS. 



 

 

 

 

SPSS automatically assumes that you want to open an existing file, and 
immediately opens a dialogue box to ask which file you’d like to open. It’ll 

make it easier to navigate the interface and windows in SPSS if we open a file. 

We’re going to open and use from data collected as part of a first-year course at 

UniSA, called Health and Society (H&S). The data we are going to use were 

collected at the beginning of 2016. So let’s first open our demonstration data 

set – the 2016 H&S student health survey data. 

Internet-based data collection 

The SDMC licenses an advanced survey software package, DatStat 

Illume, that can manage all aspects of internet-based surveys, including e- 

mailing invitations to potential study participants, sending reminder emails, and 

reporting results. The software supports programming surveys with complex 

skip patterns, multiple drafts, and frequent changes of survey instruments. 

Survey responses and survey administration variables (e.g., date of completion, 

time to complete, number of items presented, number of items answered, etc.) 

are easily extracted and exported to other programs for analysis. Illume also 

incorporates robust data security safeguards, ensuring compliance with HIPAA 

requirements and other laws and regulations governing privacy of health and 

other personal information. The SDMC also serves as the DFCI institutional 

support group for REDCap Survey software. 

Data entry 



 

The SDMC offers advanced capabilities for efficient and accurate data entry 

with quality assurance measures that ensure a clean data set prior to analysis. 

For some projects, data entry is conducted through automated form scanning 

using ReMark OCR software. 

Data analysis 

The Core provides investigators with descriptive statistical reports as well as 

univariate and bivariate statistical analyses. The Core maintains Wincross 

software that produces timely data reports, including sub-group analysis and 

statistical testing. The Core also works with biostatisticians to preparing and 

develop datasets in SAS and SPSS for advanced statistical analysis. 

Main features of spss package 

 Basic hypothesis testing. 

 Bootstrapping. 

 Cluster analysis. 
 Data preparation, charts and graphing. 

 Descriptive statistics. 

 Programmability extension. 

 ROC analysis. 
 Statistical procedures. 
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